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Chapter 14: Measure Tool

Measure Tool 
What it does
This tool adds new blank measures at the end of the score (in all staves at once).

Using this tool, you can also create different regions of measure numbering in your score. Each 
region can have a different numbering or lettering scheme; for example, you might letter the intro-
ductory measures A, B, C, and D, and then number subsequent measures beginning with 1, 2, 3, 
and so on.

When you select Edit Regions from the Measure Numbers submenu of the Measure Menu, the 
Measure Number dialog box appears, where you can define various parameters for the measure 
numbering in a region such as the font, positioning, enclosure shape (if any), and incidence of the 
measure numbers (how often they appear). See MEASURE NUMBERS for full instructions.

You can also use the Easy Measure Numbers plug-in to create measure numbers quickly. See 
EASY MEASURE NUMBERS.

Finally, when you click this tool, a handle appears on every barline; drag a barline’s handle (or 
drag within the measure) to make the measure wider or narrower. You can also double-click its 
measure handle to display the Measure Attributes dialog box, where you can specify a number of 
measure-specific parameters: the barline type, whether or not you want the key or time signature 
to appear, and so on. (See MEASURE ATTRIBUTES DIALOG BOX for more information.)

If you’ve used the Music Spacing command on a measure, it displays two handles on the barline. 
If you click the second one, Finale displays a beat chart above the measure—a set of handles you 
can drag to change the horizontal positions of the beats in all staves at once. See BEAT POSITIONS 
for full details.

Finally, if you’ve selected Allow Horizontal Split Points in the Measure Attributes dialog box for 
a measure, it displays three handles on the right barline. If you click the bottom handle, a special 
rectangle appears, in which you can designate permissible split points for the measure—places 
where Finale may break the measure over a system break if it’s too long to fit on the line; see 
MEASURES.

Special mouse clicks
• Double-click the Measure Tool to add a single new blank measure at the end of the score.

• Ctrl-click the Measure Tool to display the Add Measures dialog box, in which you can tell 
Finale how many new blank measures you want to appear at the end of the score.

• Click the Measure Tool to display a handle on every measure number and barline in the 
score.

• Ctrl-click the measure to display all measure numbers defined for a measure (even if no 
numbers are currently showing in the measure). Finale shows the measure numbers for that 
measure in that staff only (not for every measure above or below it).
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Note: Measure numbers will only appear in a staff when Measure Numbers is selected as one 
of the Items to Display in the Staff Attributes dialog box.

• Ctrl-shift-click the measure to display all measure numbers in the system.

• Click a measure number’s handle, shift-click an additional handle, or drag-enclose sev-
eral handles (with “Dragging Selects Number Handles” selected) to select specific mea-
sure numbers.

• Select a measure number’s handle and press delete, or right mouse click the handle and 
select Delete from the contextual menu to remove a measure number. Finale hides the mea-
sure number for that measure in that staff only (not for every measure above or below it).

• Drag a selected handle to reposition the measure number (and any other selected measure 
numbers). If auto-constrain dragging is not selected, press shift to constrain dragging. 

• Select the measure number’s handle, then press backspace, or right mouse click the han-
dle and select Restore Default Positioning from the contextual menu to reset a manually 
positioned measure number back to its default position. Finale moves the measure number 
back to its original position as defined in the Measure Number dialog box for the measure 
number map.

• Double-click the handle of a measure number, or right mouse click the handle and select 
Edit Enclosure from the contextual menu to display the Enclosure Designer dialog box, 
where you can select an enclosure shape or edit the shape’s height, width, center, and line 
thickness. If you no longer want an enclosure to appear on a measure number, choose None 
from the Shape drop-down list. Finale shows any changes you make to the measure number 
for that measure in that staff only (not for every measure above or below it).

When you double-click a measure number handle, the Enclosure Designer dialog box appears 
displaying an additional button labeled Use Default Enclosure. When you first display this 
dialog box, the default enclosure set in the Measure Number dialog box for the region appears 
selected in the Enclosure drop-down list. Changing the shape or editing any other settings, 
means that the default enclosure is no longer used for the measure number. Click Use Default 
Enclosure to reset the enclosure and return to the score where the default enclosure, as defined 
in the Measure Number dialog box for this region, appears on the measure number.

• Double-click a measure, or right mouse click the top handle and select Edit Measure 
Attributes from the contextual menu to display the Measure Attributes dialog box. (You can 
also double-click a measure’s handle or select a handle and press enter.)

• Drag the top barline handle right or left to make the measure wider or narrower. If you’re in 
Page View, the measure to the right of the barline gets narrower or wider to compensate.

• Click the second barline handle of a measure or right mouse click the second handle and 
select Edit Beat Chart from the contextual menu to display a beat chart, which you can use 
to change the horizontal positions of the beats in the measure (in all staves).

• Click the third (bottom) barline handle of a measure or right mouse click the top handle 
and select Edit Split Points from the contextual menu to display a split point bar, where 
you can double-click to indicate a permissible place for Finale to break the measure in half, if 
necessary, at a system break. 

• Drag one of the lower handles in a beat chart to move that beat horizontally in all staves.
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• Shift-drag the lower handle of a beat chart to move that beat and all subsequent beats in the 
measure horizontally in all staves.

• Double-click between two upper handles of a beat chart to add another upper/lower pair of 
beat positioning handles for the beat between the two original handles. Click any upper handle 
and press delete to remove it. (You can’t remove the first handle in the measure, however.)

• Double-click an upper handle of a beat chart to display the Beat Chart dialog box, where 
you can tell Finale precisely which beat’s position you want the handle you double-clicked to 
control.

• Click an upper handle (Remember that the first handle can’t be removed) to select it, where-
upon you can press delete to remove it from the beat chart.

Contextual menus
Contextual menus are reached by right mouse-clicking on the handle of an object. A contextual 
menu will be displayed where you can select various items.

Measure Tool

Menu item What it does

Add One Measure Adds one measure to the score

Add Measures Displays the Add Measures dialog box

Edit Measure Number Region Displays Measure Number dialog box

Measure Number handles

Menu item What it does

Edit Enclosure Displays the Enclosure Designer dialog box

Restore Default Position Restores the default position of the selected measure number

Delete Removes selected measure numbers

Top Measure handle

Menu item What it does

Edit Measure Attributes Displays Measure Attributes dialog box

Insert Measure Displays the Insert Measures dialog box

Delete Removes the selected measures

Break Multimeasure Rest Separates the selected multimeasure rest into separate measures of 
rests

Edit Time Signature Displays the Time Signature dialog box

Edit Key Signature Displays the Key Signature dialog box

Normal Barline Change barline for selected measure to Normal barline

Double Barline Change barline for selected measure to Double barline

Final Barline Change barline for selected measure to Final barline
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Measure Menu
How to get there

Click the Measure Tool z.

What it does
This menu allows you to add, insert and delete measures, set up multi-measure rests, control mea-
sure numbers and barline styles.

Solid Barline Change barline for selected measure to Solid barline

Dashed Barline Change barline for selected measure to Dashed barline

Invisible Barline Change barline for selected measure to Invisible barline

Tick Barline Change barline for selected measure to Tick barline

Custom Barline Change barline for selected measure to Custom barline

Second Measure handle

Menu item What it does

Edit Beat Chart Display Beat Chart handles

Third Measure handle

Menu item What it does

Edit Split Points Display Split Point handles

Top Measure handle

Menu item What it does
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•  Add. When you choose Add, Finale asks you how many new blank measures you want to add 
(in all staves) to the end of the piece. (See ADD MEASURES DIALOG BOX.) Enter the number of 
measures you want added, and click OK. (This command performs the same function as ctrl-
clicking the Measure Tool.)

• Insert. When you choose Insert, Finale asks how many measures you want to insert (in all 
staves) just before the first selected measure. Enter the number of measures you want inserted, 
then click OK. (See INSERT MEASURES DIALOG BOX.)

• Delete. When you choose Delete, Finale removes the selected measures from the piece com-
pletely—from all staves—so that there are now fewer measures in the piece.

• Multimeasure Rests: Break • Create • Edit. Use the Multimeasure Rests submenu to break 
existing multimeasure rests, create multimeasure rests regardless of whether Special Part 
Extraction is on, or edit the appearance of a multimeasure rest. Remember that you must be in 
Page View to change multimeasure rests.

Use the Break command to separate the selected multimeasure rest into separate measures of 
rests. Use this command if you simply don’t want the measures grouped at all, or if you want 
to create more than one multimeasure rest out of one long multimeasure rest.

Use the Create command to create a multimeasure rest out of the selected measures. Finale 
creates a multimeasure rest grouping using the definition you’ve set up in the Multimeasure 
Rest dialog box, located in the Document Settings submenu of the Options Menu.

It’s most effective to use the Edit command to change the display for an occasional individual 
multimeasure rest in the score. Occasionally you may need to adjust a multimeasure rest to 
make room for clef changes, for example. Or, you might need to change a rest so the number 
of rests doesn’t appear. Use the settings in the Options Menu’s Multimeasure Rest command 
to control how you want most of your multimeasure rests to appear throughout your score. See 
MULTIMEASURE REST DIALOG BOX and MULTIMEASURE RESTS.

• Measure Numbers: Edit Regions. Select this item to display the Measure Numbers dialog 
box where you can set different options for the display of measure numbers. See MEASURE 
NUMBER DIALOG BOX. 

• Measure Numbers: Add Enclosures. Select this item to add enclosures to the selected mea-
sure numbers.

• Measure Numbers: Show Numbers • Hide Numbers • Reset Defaults. Use these menu 
items to hide and show measure numbers over a region or reset them to use the settings in the 
Measure Number dialog box.

• Edit Measure Attributes. Select this item to display the Measure Attributes dialog box where 
you can set the barline style, width and other measure attributes. See MEASURE ATTRIBUTES 
DIALOG BOX.

• Dragging Selects Measure Handles • Dragging Selects Number Handles. If you want to 
select measures when you drag your mouse across them, select Dragging Selects Measure 
Handles. A checkmark will appear when selected. If you want to select measure numbers 
when you drag your mouse across them, select Dragging Select Number Handles.
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Add Measures dialog box

How to get there

Ctrl-click the Measure Tool z. Or, click a measure, and choose Add from the Measure Menu.

What it does
This dialog box lets you specify how many new measures you want added to the end of the score. 
When you add measures, the Measure Width and Position Notes Evenly settings in the Measure 
Attributes dialog box from the last measure in the piece are copied into the new added measures. 
See MEASURE ATTRIBUTES DIALOG BOX for details on these settings.

• How many measures?. In this text box, enter the number of new measures you want added or 
inserted.

• OK • Cancel. Click OK (or press enter) to add the specified measures, or Cancel to leave the 
score unchanged, and return to the score.

Insert Measures dialog box
How to get there

Click the Measure Tool z, click a measure, and choose Insert from the Measure Menu.

What it does
The Insert Measure dialog box lets you specify how many new measure you want inserted before 
the first measure of the selected region.

• How Many Measures?. In this text box, enter the number of new measures you want 
inserted.
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• OK • Cancel. Click OK (or press enter) to insert the specified measures, or Cancel to leave the 
number of measures unchanged, and return to the score.

Measure Number dialog box
How to get there

Click the Measure Tool z and select Edit Regions from the Measure Numbers submenu of the 

Measure Menu.

What it does
From the Measure Number dialog box, you can create new measure number regions (which may 
overlap), cycle through each region in your score, and display and change settings for regions. It’s 
easy to set up measure numbers, edit their appearance, hide or show them, and position them in 
the score. A drop-down list provides common measure numbering styles—1, 2, 3….a, b, c…, and 
so on—without requiring you to type in several settings to define the style; and if you prefer, you 
can create your own style. Options for selecting enclosures are available, and you can select com-
mon enclosure shapes from a drop-down list.

• Region. To display the settings for a region of measure numbers in your score, select the 
desired region from the dialog box.



Measure Number dialog box 14-8      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Includes Measure ___Through ___. Enter the numbers of the first and last measures of the 
specific region. These are the actual measures in the piece, regardless of what number you 
want displayed on them. For example, you’d enter 1 through 49 here to tell Finale that mea-
sures 1 through 49 belong to the region, but you might use a completely different numbering 
scheme for the same measures in your score (see First Measure in Region below).

• Delete • Add • Sort. Click Delete to remove the currently selected measure number region. 
Click Add to create a new measure number region after the selected region. Finale will copy 
the settings of the currently selected measure number region into the newly created region. 
Click Sort to sort all measure number regions in the order they’ll appear in the score.

• First Measure in Region. Enter a value for the measure number on the first measure in the 
region. If you selected a numeric style for your measure numbers, enter the first number that 
you want to appear in the region (1, or 2, or 3, and so on). If you selected a letter style, enter a 
number that corresponds to the position or order of the letter in the alphabet, such as 1 for A, 2 
for B, 3 for C, and so on.

• Prefix • Suffix. Enter a number, letter, or symbol in the Prefix text box that you want Finale to 
display before every measure in the region. Similarly, any number, letter, or symbol entered in 
the Suffix text box will be displayed after every measure in the region.

• Style. Choose the numeric style (1, 2, 3, 4…) or select one of four styles (a, b, c...aa, bb, cc…; 
A, B, C...AA, BB, CC…; a, b, c...aa, ab, ac…; A, B, C...AA, AB, AC…) from the Style drop-
down list. If you’d rather define your own measure numbering style, choose Other, then set up 
your own style in the Measure Number Style dialog box. See MEASURE NUMBER STYLE DIA-

LOG BOX. For some of the examples above, you may need to check Double Up in the Measure 
Number Style dialog box.

• Enclosure Shape: None • Square • Circle • Ellipse • Triangle • Rectangle • Pentagon • 
Hexagon • Septagon • Octagon • Other. Use the Enclosure Shape drop-down list to choose 
the geometric shape of the enclosures that you want to appear on measure numbers in this 
region. Choose None if you want no shape displayed with the numbers. Choose Other to dis-
play the Enclosure Designer dialog box, where you can edit a shape. For more information, 
see ENCLOSURE DESIGNER DIALOG BOX.

• Show on: Every Number • Selected Numbers. Click Show on Every Number to display the 
enclosure shape on every measure number in the region. Click Show on Selected Numbers to 
display the enclosure only on selected measure numbers in the region.

• Edit Enclosure. Click this button to display the Enclosure Designer dialog box, where you 
can edit the settings of the currently selected shape.

• Show Measure Number Ranges on Multimeasure Rests • Bracket range using Left/
Right. Select this option to have multimeasure rests in your piece display a measure number 
range. When the Show box is checked, you can enter the character to use for left or right 
brackets, such as parentheses or square brackets. Leave the Left/Right boxes blank for no 
bracket.

[5-11] 7
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• Set Font. Click Set Font to select the font Finale will use for the measure numbers in this 
region. The font that is currently selected appears next to this button.

• Show Measure Numbers at Start of Each Staff System • Show Every ___ Measures 
Beginning with Measure ___. Select Show Measure Numbers at Start of Each Staff System 
if you want measure numbers to appear at the beginning of every line. To display the measure 
number every few measures (every 5 measures, for example), starting at a particular measure 
number, select Show Every ___ Measures Beginning with Measure ___, then enter values for 
the measure number and the display interval.

• Hide First Measure Number in Region. When this option is selected, Finale will not display 
the first measure number in the region. For example, many copyists hide the measure number 
on the first measure in the score. When the option is not selected, Finale displays the measure 
number.

• Always Show on Top Staff • Always Show on Bottom Staff. Select Always Show on Top (or 
Bottom) Staff to tell Finale to always show a measure number on the top or bottom staff of 
each system, regardless of which staff happens to be at the top (or bottom) of the system.

Tip: Select one of these options if you’ve optimized your score so that all resting staves are 
removed from the staff systems in Page View. That way, if you want a measure number to 
appear in the score above the top staff, or on the bottom staff, one will always appear, even if 
measure numbers are normally turned off for that staff.

• Always Show on Multimeasure Rests. When this option is selected Finale will display the 
measure number ranges in brackets for all multimeasure rests. For example, if you have mea-
sure numbers set to only appear at the start of a system and the multimeasure rest appears in 
the middle of a system, this checkbox will override that setting.

• Position. Click to display the Position Measure Number dialog box, where you specify the 
default position of measure numbers in the score for this region. For more information, see 
POSITION MEASURE NUMBER DIALOG BOX.

• OK • Cancel. Click Cancel to return to the score without changing the measure number set-
tings. Click OK (or press enter) to confirm your settings and return to the score. The measure 
numbers appear, according to your specifications.

Measure Number Style dialog box
How to get there

Click the Measure Tool z and select Edit Regions from the Measure Numbers submenu of the 

Measure Menu. Choose Other from the Style drop-down list in the Measure Number dialog box.

What it does
This dialog allows you to set up a customized measure numbering style, other than those preset in 
the Measure Number dialog box.



Measure Number Style dialog box 14-10      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Numbering Base. Enter a number to use as the base for the measure numbering scheme in the 
current region. Use Base 10 for the standard numeric system (1, 2, 3, 4…). Finale will use the 
characters 0 through 9 before adding another digit to the measure numbers. If you’re using a 
lettering scheme, such as the English alphabet, enter 26 here. Finale goes through the 26 let-
ters of the alphabet before adding another letter to the number (A to Z, AA to ZZ, AAA to 
ZZZ, and so on).

• Starting Character. If you enter a number, letter, or symbol in the text box, Finale will use 
this character to begin sequentially numbering or lettering the specified measures in the 
region. If you click Starting Character instead of entering a character, Finale displays the 
Symbol Selection dialog box for the selected font, and you can then choose a letter, number, 
or symbol from the palette that appears.

• Count From One. Select this option if you’re beginning the measure numbers with number 1 
(which is the second character if the Starting Character is 0). If you’re using letters instead of 
numbers, or if the first measure is a pickup measure that you don’t want numbered, make sure 
this option is not selected.

• No Zero. Select this option only if you’re using letters instead of numbers. No Zero refers to 
the number or letter in the “tens” place once Finale reaches the end of the alphabet or set of 
single digit numbers. This setting tells Finale whether to use the Starting Character in the 
“tens” place for the next measure number.
Note: Although you’re not prevented from selecting this option when you’re using the stan-
dard numbering scheme, you might not get the results you expect, as Finale will label the 
measures 00, 01, 02, 03… instead of 10, 11, 12, 13… and so on.

• Double Up. Select this option if you’re using lettering instead of numbering and you want 
Finale to start “doubling up” the letters after one complete pass through the alphabet. If 
selected, Finale labels the subsequent measures AA, BB, CC, and so on. If not selected, the 
measures will be labeled AA, AB, AC… and so on.
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Note: Although you’re not prevented from selecting this option when you’re using the stan-
dard numbering scheme, you might not get the results you expect, as Finale will label the 
measures 00, 11, 22… instead of 10, 11, 12… and so on.

• OK • Cancel. Click Cancel to discard any changes you made to the settings. Click OK (or 
press enter) to confirm the settings you’ve made and return to the score. 

Enclosure Designer dialog box
How to get there

Click the Expression Tool y, and double-click a note or measure. In the selection box that 

appears, click Create (or click an existing expression and click Edit). If you like, enter or edit text 
in the Text Expression Designer text box, then click Enclose Expression.

You also find this dialog box in the Repeat Tool x. Click the tool, then click a measure. Click Create 

to create a new text repeat (a piece of text that functions as a fully operational repeat marking, 
such as “To Coda”), enter the text for the text repeat, and click Enclose Repeat.

Finally, you encounter this dialog box in the Measure Tool z. Click the Measure Tool and 

select Edit Region from the Measure Numbers menu of the Measure Menu. Click Enclosures. Or, 
double-click the handle of certain measure numbers in the score to change their enclosures. Spe-
cifically, it appears if you’ve specified Enclosures in the Measure Number dialog box for the cur-
rent region of measures. See MEASURE NUMBER DIALOG BOX for details.

What it does
This dialog box lets you enclose the expression mark (such as a rehearsal letter) or text repeat 
(such as “To Coda”) in a box of any size, geometric shape, or line thickness. If you encounter it 
using the Measure Tool, it lets you modify, add, or remove the enclosure for the measure number 
you clicked.
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• Shape: Rectangle, Oval, ... None. Use this drop-down list to select a shape such as a rectan-
gle, oval or triangle, to draw around the text, or choose None if you don’t want an enclosure to 
appear.
Note that the display shows three square handles. By dragging these handles, you can change 
the size, shape, and positioning of the enclosure, as shown:

• Line Thickness. Type the thickness, in measurement units, of the enclosure shape’s outline.

• Opaque. Select this option to make the prevent items behind the enclosure from showing 
through. This is only available for rectangles and ellipses.

• Height. Type the distance to add to Finale’s default height of the enclosure, in the selected 
measurement units (Options Menu).

• Width. Type the distance to add to Finale’s default width of the enclosure in the selected mea-
surement units (Options Menu).

Drag this handle to 
make the enclosure 
taller or shorter.

Drag this handle to 
make the entire 
enclosure larger or 
smaller.

Drag this 
handle to 
move the 
enclosure 
relative to the 
text inside.
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• Center: H: • V:. Type the amount to shift the enclosure horizontally and vertically, if you 
don’t want it centered on the text. Positive H: numbers move the enclosure shape to the right 
of the center of the text. Positive V: numbers move the enclosure shape upward from the text’s 
baseline.

• Options: None, Enforce Minimum Width, Match Height and Width. Use this drop-down 
list to control how the shape is drawn. If you choose None, Finale allows you to independently 
set the height and width of the shape. Choose Match Height and Width to display the shape 
symmetrically so that the enclosure's height matches its width. Choose Enforce Minimum 
Width to enforce a minimum width so the enclosure’s height doesn’t change when its width 
adjusts to the text.

• Fixed Enclosure Size. When this option is selected, Finale maintains the exact size of the 
enclosure despite the size of the text. When this option is not selected, Finale adjusts the width 
(and size) of the enclosure depending on which item is selected in the Options drop-down list.

• Use Default Enclosure. This option is only available when you have accessed the Enclosure 
Designer through a measure handle. If you have specified a unique enclosure, use this button 
to reset the item to use the default enclosure used in the rest of the document.

• OK • Cancel. Click OK (or press enter) to return to the previous dialog box. Click Cancel to 
return to the previous dialog box (or to the score) without making any changes.

Position Measure Number dialog box
How to get there

Click the Measure Tool z and select Edit Region from the Measure Numbers submenu of the 

Measure Menu. Click Position.

What it does
This small graphic display lets you position your measure numbers (relative to the staff) by drag-
ging it within a mock-up of a staff.

You don’t have to drag the 0 (the stand-in for a measure number) itself. Instead, drag anywhere in 
this graphic box; the 0 moves as you drag.
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• Align: Left • Right • Center. The options in this drop-down list specify the alignment of mea-
sure numbers relative to the left and right barlines (closer to one or the other, or centered 
between them). Your choice here affects the point from which the numbers in the H: and V: 
text boxes are measured.

• Distance from Staff: H: • V:. The numbers in these text boxes specify the exact default posi-
tion of the number within the measure. As always, a positive H: measurement moves the mea-
sure number to the right, and a positive V: measurement moves it upward. 

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the changes you’ve 
made in the measure number’s position. You return to the Measure Number dialog box.

Measure Attributes dialog box
How to get there

Click the Measure Tool z, and double-click the measure you want to edit. Some measure 

attributes require that you select more than one measure before double-clicking.

What it does
Each measure in Finale can have a number of specific attributes, including its barline type, bar-
line-to-barline width, whether or not it should display the key and time signature, and so on. In 
this dialog box, you can specify all of these variables for the measure you clicked. Once you’ve 
specified this information, you can use the Mass Mover to copy some of this information to other 
measures (namely, measure widths and positioning mode). See also AUTOMATIC BARLINES.

You’ll rarely need to use the Position Notes: options, which govern how the notes in the selected 
measure are positioned—particularly if you’re in the habit of using the Music Spacing command 
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to neatly respace the notes in your scores. To review the Music Spacing, see Installation & Tutori-
als, or MUSIC SPACING.

• Measure Attributes for Measure__. You can enter the number of the measure you want to 
edit or use the arrows to select another measure.

• Barlines • Left Barlines: Normal • Double • Final • Solid • Dashed • Invisible • Tick • 
Custom: Select. Click the barline icon you want for the right or left barline of the measure. 
Or, double-click to select the barline and exit the dialog box.

Finale automatically updates the display options when you select a barline style. When you 
select the Dashed, Invisible, Tick, or Custom barline, Finale deselects Break a Multimeasure 
Rest and Override Group Barlines. When you select the Double, Solid or Final barline, Finale 
automatically selects Break a Multimeasure Rest and Override Group Barlines. 

When you select the Invisible barline icon to hide a measure’s barlines, Finale also hides 
repeat bars assigned to that measure.

Select Custom to use a defined shape as a barline. Click on Select to select which shape is 
used.

See also AUTOMATIC BARLINES.

• Change Width. If you want to change the width of all the measures in the selected measure 
region, make sure this checkbox is selected.  Enter the new width in the text box. The number 
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in this text box specifies the barline-to-barline width of the measure. If you want to specify an 
extremely precise width value, you can enter it here. It’s much easier, however, to drag the 
handle on the measure’s right barline to the right or left (when you exit this dialog box). When 
you drag the barline to change the measure width, Finale automatically enters the correct 
value in the Width text box.

• Add Width. Select this text box to add the specified amount to each measure in the selected 
measure region.

• Key Signature: Show if Needed • Always Show • Always Hide. If you choose Always Show 
from this drop-down list, you force the key signature to appear in this measure, even if the 
measure doesn’t fall at the beginning of a system or a key change. On the other hand, Always 
Hide means that the current key signature won’t appear, even if it appears at the beginning of a 
new system or at a key change. Show if Needed is the usual setting—the key signature will 
only appear in the measure at the beginning of a system, or at a key change.

• Time Signature: Show if Needed • Always Show • Always Hide. Choose Always Show from 
this drop-down list to force the time signature to appear in this measure. Always Hide means 
that the current time signature won’t appear, even if it appears at the beginning of a new sys-
tem or a meter change. Show if Needed is the usual setting—the time signature will only 
appear in the measure at the beginning of a system, or at a meter change.

• Position Notes: According to the Time Signature • Manually (by Dragging) • Using Beat-
Chart Spacing. These options govern the way Finale spaces notes within the measure you’re 
editing.

According to the Time Signature is the default mode; Finale uses proportional spacing to 
place the notes in the measure. In linear spacing, a whole note, for example, is allotted exactly 
as much width as four quarter notes. When music engravers prepare music for publication, 
however, they generally use nonproportional spacing, where longer values are allotted only as 
much space as they need, which gives the music a more compact, professional appearance. 
(See Installation & Tutorials, or MUSIC SPACING).

Select Manually (by Dragging) if you want to drag each note in the measure into place, one 
by one. When you exit this dialog box, Finale superimposes all of the notes at the left end of 
the measure; to drag them into place, click the Speedy Entry Tool and click the measure. Drag 
the notes into place.

The Use Beat-Chart Spacing positioning mode works much like According to the Time Sig-
nature. However, when you return to the score, you’ll notice a difference: when the Measure 
Tool is selected, every barline of a measure whose positioning has been set in this way dis-
plays two handles at the bottom. (Measures in which you’ve respaced the music using the 
Music Spacing command also display two handles, because those commands automatically 
turn on Use Beat-Chart Spacing for the selected measures.)

When you click the bottom of the two barline handles, a beat chart appears above the measure, 
displaying vertically aligned pairs of handles. The top row of handles indicates the positions 
of the beats according to linear spacing (where a whole note gets exactly as much space as 
four quarter notes). By dragging a handle on the bottom row, you can reposition a beat in all 
staves at once. For a more complete discussion, see BEAT POSITIONS.
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• Hide Cautionary Clefs, Key and Time Signatures. Select this option if you want Finale to 
hide any cautionary changes that appear at the end of the measure.

• Position Notes Evenly Across Measure. Select this option if the measure you’re editing con-
tains more or fewer beats than are allowed by the time signature; Finale responds by spacing 
all notes evenly within the measure, no matter how few or how many. This is a useful option 
if, for example, you’re creating a cadenza whose note values add up to far more than the four 

beats specified by the measure’s  meter.

• Begin a New Staff System. Select this option if you want the measure you’re editing to 
appear at the beginning of a new system (a new line of music on the page). Note, however, that 
forcing such a system break may result in peculiar spacing of the measure or measures preced-
ing the edited measure, depending on the measure layout. When Begin a New Staff System is 

checked, a  symbol will appear in Page View to indicate that the measure must appear at 
the start of a system. For more information, see MEASURE LAYOUT.

• Break a Multimeasure Rest. This checkbox has an important effect when you extract parts. 
If the measures surrounding the one you’re editing are empty, they’ll appear in the extracted 
part as multimeasure rests (or “block rests”). If Break a Multimeasure Rest is on, however, the 
right barline of this measure will break such a multimeasure rest into two block rests, one on 
each side of it. (Such block rests automatically break for key and time changes, clef changes, 
and so on.) See MULTIMEASURE RESTS for more information.

• Allow Horizontal Split Points. If a measure is very long, you may want to split it, so that the 
second half of the measure appears at the beginning of a new system. If so, select this option. 
When you return to the score, you’ll notice a new small square handle at the bottom of the 
measure’s right barline. Click this handle; a long, thin, horizontal, rectangular strip appears 
above the measure.

Wherever you double-click within this special strip, a small square handle appears. You can 
drag this handle horizontally (or delete by selecting it and pressing delete). This handle marks 
a permissible split point; add as many split points as you want by double-clicking in the split 
point strip. Finale will split the measure at one of them only if necessary for layout purposes. 
(See MEASURES—To split a measure across a line break.)

Note, too, that if you’ve specified permissible split points in this way, you can force Finale to 
split a measure using the Mass Mover in Page View. Click the Mass Mover Tool, then click the 
measure to be split. If the measure begins a system, press the up arrow to move the first part of 
the measure up to the previous system. If the measure is at the end of a line, press the down 
arrow key to move all but the first part of the measure down to the next system.

• Override Group Barlines. Check this option if you want the barline selected in this dialog 
box to appear at the end of this measure (for all staves). When selected, this option overrides 
settings for Use Alternate Group Barlines defined in the Group Attributes dialog box. For 
more information, see GROUP ATTRIBUTES DIALOG BOX.

• Change Every ___ Measures. This option is shown only when a range of measures is 
selected. You can enter the number to specify which measures change.  For example, entering 
8 would change every 8th barline to the specified type.

4

4
---
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• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your measure 
attributes settings and return to the score.

Beat Chart dialog box
How to get there

Click the Measure Tool z, and click the bottom handle of any barline that has two handles. 

(Such measures have been specified as having beat charts.) There are two ways to provide a mea-
sure with a beat chart. First, you can set its positioning by using the Music Spacing command in 
the Edit Menu. Second, choose Using Beat-Chart Spacing in the Measure Attributes dialog box 
for the desired measure. The beat chart appears. Double-click the top handle of any pair in the 
beat chart.

What it does
A beat chart lets you change the horizontal position of a beat in all staves at once; for example, 
you might want to drag the fourth beat of a measure slightly to the left to allow room for a septu-
plet run in the strings. Finale normally provides a handle on every beat or every note in the mea-
sure.
Using this dialog box, however, you can specify a precise beat or subdivision of a beat that you 
want a particular beat chart handle to control—even if there’s no note that falls on that beat.

You can change the position of any beat handle (note or rest) within the measure numerically; 
Finale also displays the range of available values for your reference.



Beat Chart dialog box 14-19      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Beat Chart (#). This number shows which beat chart handle, in order from left to right, you’re 
editing.

• Measure (#). This number indicates which measure is represented by the beat chart.

• Elapsed Duration. The number in this text box (in EDUs, 1024 per quarter note) tells which 
beat (or which subdivision of a beat) has its horizontal positioning controlled by this handle. 
In other words, if the text box displays a value of 1024 EDUs, then you can drag the lower 
handle of the pair to the left or right to reposition the occurrence of the second quarter note in 
all staves (that is, 1024 EDUs, or one quarter note, has already elapsed).
This text box can be useful if you want to move, for example, the second note of a triplet 
slightly to one side (in all staves). By calculating the appropriate EDU value to enter into the 
Elapsed Duration text box, you can specify precisely which element of the triplet you want the 
handle to control. (In this example, if the quarter-note triplet begins on the first beat, you’d 
type 682 into the text box, because that’s one-third of 2048 [the total EDU value of the quar-
ter-note triplet].)
To make this handle control another beat in the measure, type its EDU equivalent in this text 
box. The number must be within the displayed range.

• Position. The number in this text box, in measurement units, tells you the current position of 
the handle and any notes or rests that line up with it.

• End Position. The number in this text box, in measurement units, tells you how close to the 
beginning of the next beat (or the end of the measure) you can adjust the note or rest.
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• Minimum Position. The number in this text box, in measurement units, tells you how close to 
the end of the previous beat (or the beginning of the measure) you can adjust the note or rest.

• Duration Range. This display shows you the smallest and the largest note duration you can 
edit within the range of notes. The range shows the values for the notes on either side of the 
note you selected by double-clicking its Beat Chart handle.

• Position Range. This display shows you the allowable values for this beat element's lower 
handle, from the end of the previous beat (or the beginning of the measure) to the beginning of 
the next beat (or the end of the measure).

• Total Duration. The number in this text box, in EDUs (1024 per quarter note), tells you the 
total duration of the measure.

• Total Width. The number in this text box, in measurement units, tells you the total width of 
the measure.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, any changes you’ve 
made in this dialog box and return to the beat chart.

Barlines dialog box
How to get there
Choose Barlines from the Document Settings submenu of the Options Menu to display the Bar-
lines dialog box.

What it does
The Barlines dialog box provides global settings that allow you to tailor barlines to a consistent 
appearance and placement in your score, without having to edit each barline individually. You can 
fine-tune the appearance of barlines by separately specifying the thicknesses of the thin and heavy 
lines, by setting line spacings for thin, thick and final barlines, and by defining the dash length and 
dash spacing for dashed barlines. You can also direct Finale to display or hide left barlines on sin-
gle and multiple staves (which is useful for scores with optimized page layout), and place final 
barlines through all staves at the end of each system or at the end of the piece.
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• Heavy Line Thickness. This setting defines the line thickness of the heavy line used for the 
Final and Solid barlines. Enter a value (in measurement units) for the desired heavy line thick-
ness. Finale’s default thickness is .042 inches (three points).

• Thin Line Thickness. This setting defines the thickness of the thin line used for barlines. 
Enter a value (in measurement units) for the thin line thickness. Finale’s default value for thin 
line thickness is .008 inches.

• Space Between Double Barlines. This setting defines the amount of distance between the 
two lines used for double barlines. The default distance is one half-space. Enter a larger value 
(in measurement units) to move the two lines farther apart and increase the space between the 
lines. Enter a smaller value (in measurement units) to bring the lines closer together.

• Space Between Final Barlines. This setting controls the distance between the two lines used 
for final barlines. The default distance is one half-space. Enter a larger value (in measurement 
units) to move the two lines farther apart and increase the distance. Enter a smaller value (in 
measurement units) to move the lines closer together.
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• Dash Length. This setting controls the length of the dash used for dashed barlines. The 
default value is .0625 inches (4.5 points). Enter a larger value (in measurement units) to 
lengthen the dash. Enter a smaller value to shorten the dash.

• Dash Space. This setting controls the space between dashes used for dashed barlines. The 
default value is .0625 inches (4.5 points). Enter a larger value (in measurement units) to widen 
the gap between dashes. Enter a smaller value to narrow the gap between dashes.

• Display All Barlines. When selected, Finale displays all barlines in your score.

• Close Barline at End of Each System. Select this checkbox if you want Finale to ignore the 
regular staff grouping at the end of each staff system, and draw the barline you selected for the 
end of each staff system through all the staves.

• Close Barline at End of Piece. Select this checkbox if you want Finale to ignore the regular 
staff grouping in the last measure, and draw the barline you selected for the last measure of the 
piece through all the staves.

• Final Barline at End of Piece. Select this checkbox if you want Finale to automatically place 
a final barline at the end of the piece. Even if you add or delete measures, the last measure will 
always have a final barline.

• Left Barlines: Display on Single Staves • Display on Multiple Staves • Default Style is 
Normal Barline • Default Style is Previous Measure’s Right Barline. You can control 
whether Finale draws the left barline on a single staff, or on all staves in each staff system in 
the piece. Select the Single Staves option to have Finale draw barlines in each staff system that 
contains only a single staff, such as a solo line. If this is not selected left barlines will not dis-
play on a single staff no matter which left barline style is selected. Select the Multiple Staves 
option to draw the left barline in staff systems that contain two or more staves, such as a piano 
part. If you want Finale to display every left barline on every staff system, select both check-
boxes. Deselect both options if you want to hide every left barline on every staff system. These 
options are useful when you prepare a score for creating parts. Before extracting parts, select 
the Multiple Staves option so that the left barline is drawn through the staves in each system, 
and deselect the Single Staves option. Finale will know to omit the left barline on each part.

You can also set the default for the left barline style, whether it will be a normal barline, or if 
it will follow from the previous measure. For example, if you have a double barline in the pre-
vious measure and would like to start the next measure at the start of the system with a double 
barline, select Default Style is Previous Measure’s Right Barline. If you prefer a different style 
of left barline, you can override the defaults using the left barline settings in the Measure Tool. 
See MEASURE ATTRIBUTES DIALOG BOX.

• OK • Cancel. Click OK (or press enter) to save the new settings, or click Cancel to discard 
any changes. You return to the score.



Clear Measure # Positioning Plug-in 14-23      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

Clear Measure # Positioning Plug-in
How to get there
Select a region with the Measure Tool (or any other tool with regional selection). Select Clear 

Measure # Positioning from the Plug-ins Menu.

What it does
The Clear Measure # Positioning plug-in allows you to clear any individual positioning applied to 
measure numbers in the selected region.

Easy Measure Numbers Plug-in
How to get there
Select the region using the Measure Tool (or any other tool with regional selection) and choose 

Easy Measure Numbers from the Plug-ins Menu. See PLUG-INS MENU for more information on 

plug-ins.

What it does
The Easy Measure Numbers plug-in allows you to easily place measure numbers over a region of 
the score. If you already have a measure number map in that region, you will be notified. You may 
have more than one measure number map for a region of measures. Click OK to continue creating 
another measure number map, or cancel to return to the score without creating a measure number 
map.

• Number the measures in the selected region starting with:. Enter the first number of the 
measure number range you want to create.

• OK • Cancel. Click OK to create a measure number map starting with the specified number. 
Click Cancel to return to the score with making any changes.
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Automatic Barlines Plug-in
How to get there
Select a region using the Measure Tool (or any other tool with regional selection). Select Auto-

matic Barlines from the Plug-ins Menu. If there is no Mass Mover Selection when you invoke the 

Automatic Barlines command, it will ask you if you want to process the entire document. See 
PLUG-INS MENU for more information on plug-ins.

What it does
The Automatic Barlines plug-in allows you to automatically set up barlines, matching the key 
changes in your document. 

In a high variety of music it is conventional to use a double barline when the key changes. The 
Automatic Barlines plug-in supports this convention by: (1) setting all barlines between measures 
in the same key to a single (normal) barline and (2) setting all barlines between measures where a 
key change is initiated to a double barline. Additionally, if the last measure of the selection is the 
last measure in the document, a final barline is placed in this measure. (Repeat barlines are not 
affected by this plug-in.)

If there is no Mass Mover Selection when you invoke the Automatic Barlines command, it will 
ask you if you want to process the entire document.

Using the Automatic Barlines Plug-in
Use the Measure Tool to select a region (or any other tool with regional selection) in which you 
wish to have the barlines match key changes, then choose the Automatic Barlines command from 

the Plug-ins Menu. The plug-in will go through the selected region, measure by measure, and 

compare consecutive pairs of measures. If a pair of measures is in the same key, the plug-in will 
set the measure attributes of the first measure to use a single (normal) barline. If there is a change 
of key, the plug-in will set the measure attributes of the first measure to use a double barline. If the 
last measure in the document is included in the selection, the measure will be set to use a final bar-
line (double barline with a thick second line).

Notes
• The Automatic Barlines plug-in recognizes that relative Major and Minor keys (for instance: C 
Major and A Minor) have the same key signature (in this case, no sharps or flats). In cases such as 
these the plug-in sets a single barline since it recognizes that the key signatures are identical, even 
though, technically speaking, the key has changed. However, the plug-in cannot analyze the key 
signatures of Non-Linear Key Signatures, nor of Linear Key Signatures beyond the conventional 
Major and Minor modes. If your music uses non-standard signatures and two adjacent measures 
use different keys with identical key signatures, the plug-in will “think” a key change has taken 
place. In this case, a double barline will be set between the two measures in question.
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Multimeasure rests
You can create a multimeasure rest (or sometimes referred to as a block rest) two different ways 
with Finale. One way is by Extracting Parts or turning on Special Part Extraction. This will create 
multimeasure rests in your entire score, and all the rests will look the same.

You can also use the Measure Tool to quickly create multimeasure rests in a selected region or for 
the entire piece. You can change the appearance of a single multimeasure rest without affecting 
the appearance of the other rests in the score. Also, you can choose to use shapes and/or symbols 
for multimeasure rests in the same piece, and control when Finale should display the number 
which indicates how many measures are in the rest.

Note: You must be in Page View to use the Break, Create, or Edit multimeasure rest commands.

To set up the appearance of multimeasure rests
Use the Multimeasure Rest command in the Document Settings submenu of the Options Menu to 
set up the default appearance of most of the rests in your score. 

• Choose Multimeasure Rest from the Documents Settings submenu of the Options Menu. 

• Specify how you want the multimeasure rests to appear when you use Extract Parts (in 
the File Menu), when you turn on Special Part Extraction (in the Edit Menu) for one or 
more staves, or when you choose Create (in the Measure Menu’s Multimeasure Rests 
submenu). For details about the settings in this dialog box, see MULTIMEASURE REST DIALOG 
BOX.

• Optional: If you want to use a Shape to notate multimeasure rests, make sure that Start 
Numbering at ___ Measures is set to two measures. Finale will display a number on all 
multimeasure rests in your score. If you prefer that no number appears—as when using the 
new symbolic rest style, for example—enter the number of measures to be included in a mul-
timeasure rest before Finale will display the number.

• Click OK when your settings are complete. Finale uses these settings when you create mul-
timeasure rests in the score. If you need to change the settings for a single multimeasure rest, 
use the Edit command in the Multimeasure Rests submenu (in the Measure Menu).

To display symbols for multimeasure rests

• Choose Multimeasure Rest from the Document Settings sub-menu of the Options Menu. 

3 measures

7 measures

9 measures
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• Select Use Symbols for Less Than ___ Measures. Finale’s default number of measures for 
using rest symbols (instead of shapes) is nine. Symbols are usually used for rests containing 
up to eight measures, and shapes are used for rests containing nine or more measures.

• Optional: If you want to use symbols for multimeasure rests containing fewer or more 
measures than the default of nine measures, enter the number of measures in the Use 
Symbols for Less Than ___ Measures text box. 

• Optional: If you want a number to appear over the rest shapes only (not over the rest 
symbols), make sure that Start Numbering at ___ Measures is set to nine (or set to the 
number of measures you specify in the Use Symbols for Rests Less Than ___ Measures 
text box). 

• Click OK when your settings are complete. Finale uses these settings when you create mul-
timeasure rests in the score. If you need to change the settings for a single multimeasure rest, 
use the Edit command in the Multimeasure Rests submenu (in the Measure Menu).

To break a multimeasure rest
When you create parts using Finale’s Extract Parts or Special Part Extraction command, Finale 
groups all empty measures into multimeasure rests. You can now break one or more multimeasure 
rests into separate measures. For example, you might prefer that measures are written out if less 
than four consecutive measures are empty, or you might want to break a single multimeasure rest 
into two or more rests. 

• Click the Measure Tool z. 

• Select the multimeasure rest to break. To break more than one multimeasure rest, select 
a region that contains the rests. (Remember that you must be in Page View to do this.)

• Choose Break from the Multimeasure Rests submenu in the Measure Menu or right-
click on the top measure handle and choose Break Multimeasure Rest. Finale breaks the 
multimeasure rests in the selected region into separate measures of rests.

• Choose Update Layout from the Edit Menu to ensure that Finale is displaying the cur-
rent layout of the score. 

To create a multimeasure rest
When you create parts using Finale’s Extract Parts or Special Part Extraction commands, Finale 
groups all empty measures into multimeasure rests. If you would rather control which measures 
get combined into multimeasure rests, you can select the measures that you want to combine into 
a multimeasure rest in your score. 

• Click the Measure Tool z. 

• Select the region that contains the measures you want to display as a multi-measure rest. 
You can also select your whole score. (You must be in Page View to do this.)



Measure numbers 14-27      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Choose Create from the Multimeasure Rests submenu in the Measure Menu. Finale cre-
ates multimeasure rests in the selected region, using the same rules as when you use Special 
Part Extraction to create rests—breaking them at key and time signatures, or when you’ve 
selected Break a Multimeasure Rest in the Measure Attributes dialog box for the measure. In 
order for measures to be grouped, they must contain default whole rests. If a whole rest was 
entered in a measure, that measure will not be included in a multimeasure rest until you erase 
the whole rest (using the Simple Entry or Speedy Entry tools, or the Mass Mover Menu’s 
Clear commands).

• Choose Update Layout from the Edit Menu to ensure that Finale is displaying the cur-
rent layout of the score. 

To edit the appearance of a multimeasure rest
When you edit a multimeasure rest using the Measure Menu, you’ll change the appearance of the 
selected rest only. (If more than one multimeasure rest is selected, Finale changes only the first 
rest in the region.)

Note: If you find that you’re using the Edit command frequently to change rests, consider chang-
ing the global settings in the Options Menu. See “To set up the appearance of multimeasure rests.”

• Click the Measure Tool z. 

• Select the multimeasure rest you want to change. (You must be in Page View to do this.)

• Choose Edit from the Multimeasure Rests submenu in the Measure Menu. 

• Specify the settings that you want Finale to use for this multimeasure rest. 

• Click OK to return to the score, where Finale displays your new settings. 

• Choose Update Layout from the Edit Menu to ensure that Finale is displaying the cur-
rent layout of the score. 

To display a measure number range for a multimeasure rest

• Click the Measure Tool z. 

• Choose Edit Region from the Measure Numbers submenu of the Measure Menu. 

• Click Show Measure Number Ranges on Multimeasure Rests. Additionally you can click 
Always Show on Multimeasure Rests force ranges no matter what the other settings.

• If your measure number is not displayed, choose Show Number from the Measure Num-
bers submenu of the Measure Menu. The current multimeasure rest is not designated to 
show in the current measure number region, show it must be forced on.

Measure numbers
You can create different regions of measure numbers in your piece, each with a different font, 
position, and numbering scheme. If you want measure numbers to occur only at specific places in 
the score to serve as rehearsal numbers, see EASY MEASURE NUMBERS and REHEARSAL LETTERS.
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To create measure numbers

• Click the Measure Tool z and select Edit Regions from the Measure Numbers sub-

menu of the Measure Menu. The Measure Number dialog box appears. If there is no mea-
sure number region click Add.

• Enter the Measures to include for this region. The Include Measure and Through text boxes 
are the actual measures in the piece; they have nothing to do with what you’re going to call 
them. For example, if the piece begins with a pickup measure, you’ll probably want what is 
actually measure 2 to be numbered as measure 1; if so, type 2 into the first text box. If you 
simply want to number every measure sequentially (a single region), type 1 into the first text 
box and 1000 (or any number larger than your actual measure count) in the second text box. If 
you want to define a region to number only part of the piece, the End Measure is the last mea-
sure to be numbered.

• Enter the number you want to start your region numbering with in the First Measure in 
Region text box. If you want to use letters, type in a number corresponding to its place in the 
alphabet.

• Select the style of measure numbers (numeric, alphabetic, etc.) from the Style drop-
down list. 

• Click Set Font to choose a font and style for this region. Click OK (or press enter). 

• Click Position. The Position Measure Number dialog box appears, displaying a symbolic 
measure number.

• Drag anywhere in the graphic box to position the measure number relative to the mea-
sure. Click OK (or press enter). You return to the Measure Number dialog box, where you 
can make various other settings.

• Specify the incidence of the numbers. If you click Show Measure Number at Start of Each 
System, a measure number will only appear at the beginning of a new system. If you click 
Show every __ Measures beginning with __, you can specify how often a number appears and 
where it should start from. Multiple of 1 would number every measure in the region.

• If you want each measure number to be prefixed, enter the Prefix number or letter. If you 
entered the letter A in the Prefix text box for a region with numbered measures, for example, 
you’d create a sequence of measures labeled A15, A16, A17, and so on. On the other hand, if 
you entered the number 21 in the Prefix text box for a region with lettered measures, you’d 
create a sequence of measures labeled 21a, 21b, 21c, and so on. 

• If you want an enclosure around each measure number, select an enclosure from the 
drop-down list. If you don’t see one you like, click Edit Enclosure and the Enclosure 
Designer dialog box appears. See ENCLOSURE DESIGNER DIALOG BOX.

If you want every measure number in the region to be enclosed, select Show Enclosure on 
Every Number. If you click Show Enclosure on Selected Numbers, no measure numbers will 
be enclosed when you first return to the score; to add the enclosure you specified to a particu-
lar measure number, simply double-click the number’s handle and click Use Enclosure.
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• If you want a range of measure numbers on multimeasure rests select Show Measure 
Number Ranges on Multimeasure Rests. If you want the range to always appear, also select 
Always Show on Multimeasure Rests. If you want a bracket around the range, enter the 
bracket in the Left and Right boxes.

• If you don’t want the measure numbers to begin with 1, enter a number in the First 
Measure in Region text box. See MEASURE NUMBER DIALOG BOX for more information.

• To set up the parameters for another region, click Add. To remove a region, click Delete. 

• Click OK (or press enter). The numbers appear in every measure in every staff. Each number 
has a handle.

To remove measure numbers from a single staff

• Click the Staff Tool s, and double-click the staff whose numbers you want to “turn 

off.” The Staff Attributes dialog box appears.

• In the Items to Display section, click Measure Numbers to de-select it. Click OK (or 
press enter). 

To move a single measure number

• If the measure number handles aren’t already visible, click the Measure Tool z. A 

handle appears on each measure number in the score.

• Drag a number by its handle to reposition it. Select it and press the arrow keys to 
“nudge” it for fine positioning. To restore a number to its original positioning, click its han-
dle and press backspace. To remove the measure number press delete.

To add a measure number to an existing region

• Click the Measure Tool z. Ctrl-click a measure which is part of a region, but is not 

currently displaying a number. To add a measure number to the entire system, ctrl-shift-
click. To remove a forced measure number, click its handle and press delete.

To reshape or remove a measure number’s enclosure
The Measure Number dialog box offers two ways of creating enclosures around measure num-
bers. If you select an Enclosure and then click Every Number, Finale places an enclosure around 
every number in the region; while you can resize an individual enclosure of this type, you can’t 
remove it.

If you select an Enclosure and then click Selected Numbers in the Measure Number dialog box, 
you add enclosures to one number at a time in the score, by double-clicking its handle and then 
clicking OK. You can both resize and remove an individual enclosure of this type.

• Click the Measure Tool z. Double-click the handle of an enclosed measure number. 

The Enclosure Designer dialog box appears, letting you reshape the enclosure and reposition 
the number within it.

• If you want to remove the enclosure, select None for the enclosure shape and click OK. 
You return to the score (provided that the enclosure isn’t an Every Number type).
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• If you want to modify the enclosure, drag the top and side handles to change its height 
and width. Drag the number’s handle to reposition the number within the enclosure. 
Change the line thickness, if desired. The line thickness is measured in points (of which 
there are 72 per inch); note that the two text boxes represent a whole digit and a decimal digit.

• Click OK. 

Beat positions
When using Finale, beats are positioned according to nonlinear spacing—in other words, the posi-
tioning of beats in a measure that contains a half note and four eighth notes won’t be the same as 
in a measure with four eighths and a half note—even though the measures are the same width. See 
MUSIC SPACING for a more complete discussion.

Each measure has beat chart (when using Automatic Music Spacing), providing handles that you 
can drag horizontally to reposition the beats in a measure. Moving a beat is not the same as mov-
ing a note—when you move a beat, the note that falls on that beat in every staff moves at once.

To create a beat chart in one measure
Until a measure has a beat chart, you won’t have control over the positions of the individual beats. 
If you apply the Music Spacing command to a certain measure, you affect the spacing of the notes 
and provide a beat chart; see MUSIC SPACING. The following method, on the other hand, adds a 
beat chart to the selected measures without changing the spacing of the music in them.

• Click the Measure Tool z, and double-click the barline handle of a measure. The 

Measure Attributes dialog box appears.

• From the Position Notes drop-down list, choose Using Beat-Chart Spacing. Click OK. To 
copy the positioning mode you’ve just established to other measures, you’ll need to turn off 
Automatic Music Spacing in the Edit Menu. Next, click the Mass Mover Tool. From the Mass 
Mover Menu, choose Copy Measure Items; from the next dialog box, click Measure Position-
ing, and press enter twice. Drag the measure you’ve already modified so that it’s superimposed 
on the first target measure. Finale asks how many times you want to copy the positioning 
mode; enter the appropriate number and click OK (or press enter).

To move a beat
This process won’t work unless the measure in question has a Beat Chart (see MUSIC SPACING or 
“To create a beat chart in one measure.”

• Click the Measure Tool z. Two stacked handles appear on each barline.
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• Click the bottom barline handle of the measure in question. The beat chart appears above 
the measure. The top row of handles indicates the positions of the beats according to the time 
signature (as they were before you respaced the music). By dragging a handle on the bottom 
row, you can reposition a beat in all staves at once.

When you click on the bottom barline handle, a beat chart appears. The top row of handles indicates 
the positions of the beats as they’d fall with linear spacing, and the bottom row of handles allows 
you to move beat positions by dragging them.

• Drag the desired beat’s handle horizontally. If you press shift while dragging, all handles to 
the right of the dragged handle move in tandem. If you double-click between two top-row han-
dles, a new handle appears, which governs the position of the beat halfway between the han-
dles on either side. 

If you double-click any top-row handle (except the first), the Beat Chart dialog box appears. 
See the BEAT CHART DIALOG BOX for more details.

Measures
See also MEASURE LAYOUT.

To add blank measures at the end of the document

• Ctrl-click the Measure Tool z. A dialog box appears, asking how many measures you 

want to add.

• Enter the desired number of measures. Click OK (or press enter). You can also choose 
Add from the Measures Menu. The same dialog box appears. (Or, to add a single measure at 
the end of the score, simply click the Measure Tool.)

To insert blank measures within a document

• Click the Measure Tool z. 

• Click the measure after the point of insertion. Even if there is more than one staff, click a 
single measure. Finale adds a blank measure in every staff.

• From the Measure Menu, choose Insert or right-click on the top measure handle and 
choose Insert Measures. A dialog box appears, asking how many measures you want to 
insert.

• Enter the desired number of measures. Click OK (or press enter). 
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To erase or remove measures

• Click the Measure Tool z and select a region. See SELECTING MUSIC for some hints on 

selecting regions.

• If you want to remove the measures from the score, choose Delete from the Measure 
Menu or right-click on the top measure handle and choose Delete. Choosing Delete 
removes the selected measures from every staff, even if only one is selected. The result: your 
score contains fewer measures.

To delete a measure from a single staff
In general, when you remove a measure from the score, Finale removes the measure in question 
from every staff in the score. Using the following technique, however, you can remove a measure 
from a single staff (in effect) by sliding the subsequent measures one measure to the left.

• Click the Mass Mover Tool l, and click the next measure after the measure you want 

to delete. If Select Partial Measures is selected in the Mass Mover Menu, then double-click 
instead.

• Choose Select Region from the Edit Menu. The Select Region dialog box appears. Finale 
displays the staff name (or number) and measure number of the measure you clicked in the 
From: and Through: areas. Now you need to change the Through Measure text box to indicate 
the end of the staff.

• Delete the number in the Through Measure text box. Leaving this text box blank indicates 
the end of the piece.

• Click OK (or press enter). 

• Drag the first selected measure to the left, so that it’s superimposed on the measure you 
want to delete. Finale asks you how many times you want the selected music copied. The 
default value, once, is what you want.

• Click OK (or press enter). Finale moves the music you selected one measure to the left, in 
effect eliminating the measure you wanted to remove. There may now be an extra measure at 
the end of the staff; just erase or remove it (see “To erase or remove measures”).

To change one measure’s width

• Click the Measure Tool z. A handle appears on each barline.

• Drag the right barline of the measure in question to the right or left. You can also click 
inside the measure itself and drag to the right or left.

To adjust measure widths in a system
It’s useful to remember that you can adjust the relative widths of the measures in any particular 
system. 

• Go to Page View, if you’re not already there. You change views by choosing Page View 
from the View Menu.

• Choose Update Layout from the Edit Menu. 

• Click the Measure Tool z. A handle appears on every barline.
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• Drag the handle of any measure to the right or left. As you make one measure wider, the 
one to its right becomes narrower. (You can adjust all measures in a system except the last one 
with this method.)

To change the widths of many measures

• Click the Measure Tool z. 

• Select the measures to be resized. You only need to select the region in one staff; the measure 
widths will be changed in all staves. See SELECTING MUSIC for some region-selecting short-
cuts.

• From the Measure Menu choose Edit Measure Attributes. The Measure Attributes dialog 
box appears, letting you specify a fixed width for all selected measures or to add or subtract a 
certain amount from all selected measures. The units are whatever you’ve selected using the 
Measurement Units command in the Options Menu.

• If you want to set the selected measures to a uniform width, enter a value into the Width 
text box. If you want to add or subtract the same amount of width in all the selected measures, 
enter a positive number (to widen) or negative number (to narrow) in the other text box.

• Click OK (or press enter). Be sure to choose Update Layout from the Edit Menu (or press 
ctrl-U) before printing or viewing in Page View.

To specify minimum or maximum measure widths
Using this method, you can tell Finale not to make any measure wider or narrower than a certain 
width. 

• Choose Music Spacing Options from the Document Settings submenu of the Options 
Menu. The Music Spacing Options dialog box appears.

• In the Minimum Measure Width text box, enter the minimum measure width you want 
to allow in the selected region. The units are whatever you’ve selected using the Measure-
ment Units command (Options Menu). Enter a Maximum Measure Width too, if you want.

• Click OK (or press enter). When you use the Music Spacing command (see MUSIC SPAC-

ING), Finale will check all the measures you’ve selected, to make sure they’re within the width 
range you specified. If any measures are narrower than the minimum, Finale sets them to that 
minimum width (and shortens any that are longer than the maximum width).

To split a measure across a line break
There may be times when you want a very long measure (such as a cadenza measure) to break in 
half if it straddles a system break. The following instructions result in a measure that may break at 
the end of a system, but only if Finale thinks it’s necessary. (You can, however, force the measure 
to break, as described in the note below.)

• Click the Measure Tool z, and double-click the barline handle of the measure you 

want to split. The Measure Attributes dialog box appears.

• Select Allow Horizontal Split Points. Click OK (or press enter). When you return to the 
score, a new handle appears at the bottom of the measure’s right barline.



Measures per line 14-34      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Click the handle at the bottom of the barline. A special “split-point rectangle” appears 
above the measure.

• Double-click in the split-point rectangle. A handle appears. Drag it horizontally to tell 
Finale precisely where it may break the measure (if necessary). Double-click in as many 
places as you want to provide additional permissible split points. To remove a split point han-
dle, click it and press delete.

• Choose Update Layout from the Edit Menu. You won’t see the effects of your split point 
until you choose Update Layout.

Note: If you want to force the measure to split, after you have added a split point, click the 
Mass Mover Tool, click the portion of the measure you want to move, and press the up or 
down arrow, as described in MEASURE LAYOUT—To move a measure to the previous (or next) 
system. (If you’ve specified more than one split point, Finale breaks the measure at the first 
designated split point, regardless of whether you press ↑  or ↓ .)

To arrange measures on the page
See MEASURE LAYOUT.

Measures per line
Finale can automatically lay out a certain number of measures per system for you—either within a 
certain region, or for the entire piece.

To specify a number of measures per line (within a region)
• Choose Page View from the View Menu, if you’re not already there. 

• Click the Mass Mover Tool l, and select the range of measures for which you want to 

specify the number of measures per line. See SELECTING MUSIC for some region-selecting 
shortcuts. If you want the same number of bars per line for the entire piece, choose Select All 
from the Edit Menu.

• Choose Fit Music from the Mass Mover Menu. The Fit Music dialog box appears.

• Enter the number of measures per system for this document. 

• Click OK (or press enter). This technique creates measure groups, which don’t float from 
one system to another as the page layout changes. See MEASURE LAYOUT for more informa-
tion on measure groups.

To remove measure groups from the current page to the end
This process will undo the procedure above, restoring all measures to “floating” status—in other 
words, their system affiliation may change as the page layout changes.

• While pressing shift, choose Update Layout from the Edit Menu. 

To remove measure groups from a selected region

• Click the Mass Mover Tool l, and select the system for which you want to remove 

measure groups. 
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• Press U to unlock the system. This will allow the measures to reflow during Fit Music opera-
tions. See MASS MOVER TOOL for more information.

Cadenzas
A cadenza—an unmeasured, free, often improvisatory solo passage—presents several notational 
challenges. First, the notes are often smaller than usual; see CUE NOTES for instructions. Second, 
there may be many more notes within a measure than the time signature would normally allow. 
There are different ways of creating a cadenza, but here are two of the most popular approaches.

To permit unlimited notes in one measure (Time Signature method)
Using this method, you can enter as many notes as you need and modify them easily later. With 
this method, you can also create inner voices that line up with each other.

• Click the Time Signature Tool d, and click the cadenza measure. The Time Signature 

dialog box appears.

• Click the top right scroll bar arrow to increase the number of beats in the measure until 
it equals the total number of beats in the cadenza. For example, a 54/4 measure.

• Click OK. You return to the score, where a time signature appears in the cadenza measure and 
the next measure.

• Click the Measure Tool z; double-click the barline handle of the cadenza measure. 

The Measure Attributes dialog box appears.

• From the Time Signature drop-down list, choose Always Hide. 

• Click OK (or press enter). Repeat for the measure after the cadenza.

To permit unlimited notes in one measure (Position Notes Evenly method)
Using this method, you can make Finale space an unlimited number of notes evenly in a measure, 
regardless of the meter.

• Click the Measure Tool z; double-click the barline handle of the cadenza measure. 

The Measure Attributes dialog box appears.

• Select Position Notes Evenly Across Measure.

• If you want to hide the ending barline (to continue the cadenza onto the next line), click 
the Invisible barline icon.

• Click OK (or press enter). Enter the music into the modified measure with the Speedy Entry 
Tool, after making sure you’ve turned Jump to Next Measure off (in the Speedy Menu). Use 
the slash (/) key to break or create beams within the cadenza. When you exit the measure, the 
There Are Too Many Beats alert box appears; simply press enter (Make sure that Leave the 
Measure Alone is selected).
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Double barlines
See also AUTOMATIC BARLINES.

To create a double barline

• Click the Measure Tool z; then double-click the barline handle of the measure you 

want to end with a double bar. The Measure Attributes box appears.

• Click the Double barline icon. Click OK. To restore the single barline, repeat the process, 
but click the leftmost (normal) barline icon.

Final barline
See also AUTOMATIC BARLINES.

To create a final barline

• Click the Measure Tool z; double-click the barline handle of the measure you want 

to end with a final barline. The Measure Attributes dialog box appears.

• Click the Final barline icon. Click OK. 

To turn off automatic final barline
• From the Options Menu, choose Document Settings, Barlines.

• Uncheck Final Barline at End of Piece.

Left barlines
To create a double left barline
• From the Options Menu, choose Document Settings, Barlines. The Barlines dialog box 

appears.

• Under Left barlines, check Display on Single Staves and Display on Multiple Staves, as 
appropriate. Click OK. For more information, see BARLINES DIALOG BOX.

• Click the Measure Tool z; then double-click the measure you want to begin with a 

double barline. The Measure Attributes box appears.

• In the Left Barline row, click the Double barline icon. Click OK. You return to your score, 
where Finale has drawn a double barline along the beginning of the system.
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System (line) break
Finale automatically chooses the most logical measure at which to create system breaks. You can, 
however, create any system breaks you wish, even if they occur in the middle of a measure.See 
MEASURES PER LINE for more information on locking and unlocking systems.

To create a system break
You can specify any measure to begin a new system, no matter what the measure layout may be in 
other systems.

• Click the Measure Tool z. A handle appears on each barline.

• Double-click the measure you want to appear at the beginning of a new system. The Mea-
sure Attributes box appears.

• Select Begin a new staff system. Click OK (or press enter).

• From the Edit Menu, choose Update Layout. The measure you specified now begins a new 

system and displays a non-printing Begin New System icon  in Page View to indicate 
that the measure must appear at the start of a system. The measure will always begin a new 
system, no matter how the page layout may change. Be careful how you use this technique, 
however; it could result in unusual measure widths preceding the affected measure (for exam-
ple, the preceding single measure could stretch across the entire system).

To move a measure to the previous (or next) system
See MEASURE LAYOUT—To move a measure to the previous (or next) system.

To split a measure across a line break
See MEASURES—To split a measure across a line break.
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